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ÖZET 

ÜÇ RAY KAYMA DENEYĠ ĠLE RĠJĠT KÖPÜKLERĠN KAYMA 

PARAMETRELERĠNĠN BELĠRLENMESĠ 

Tuğçe SARGIN 

Yüksek Lisans Tezi, ĠnĢaat Mühendisliği Anabilim Dalı 

DanıĢman: Doç. Dr. Ġzzet Ufuk ÇAĞDAġ 

Mayıs 2018; 46 sayfa 

Sandviç yapıların yapısal davranıĢlarını daha iyi anlayabilmek ve 

performanslarını arttırmak için, kullanılan çekirdek malzemelerinin kayma modülü ve 

kayma dayanımı değerlerinin doğru bir Ģekilde belirlenmesi gerekir. Bu nedenle bu 

çalıĢmada, hafif bir polistren köpük (PK) çekirdek malzemesinin ilgili malzeme 

düzlemlerindeki kayma modülleri ve kayma dayanımı değerleri, üç ray kayma deneyi 

(ÜRKD) yapılarak elde edilmiĢtir.  

Öncelikle rijit bir ÜRKD düzeneği imal edilmiĢtir. Kuvvetli düzlem için üç ve 

zayıf düzlem için üç olmak üzere toplam altı adet deney yapılmıĢtır. Elde edilen deney 

neticeleri kullanılarak sayısal ve analitik modeller vasıtasıyla PK çekirdek 

malzemesinin kayma modülü değerleri yaklaĢık olarak hesaplanmıĢtır. Sayısal model, 

ANSYS programı kullanılarak oluĢturulmuĢ ve analitik model için kayma 

deformasyonunun dahil edildiği klasik kiriĢ teorisi kullanılmıĢtır. 

Bu çalıĢmada elde edilen sonuçlar, ÜRKD'nin kayma modüllerini belirlemede 

kullanılabileceği ama kayma dayanımının belirlenmesinde ihmal edilemeyecek oranda 

hatalı sonuçlar verdiğinden bu maksatla kullanımının uygun olmadığını göstermektedir. 

 

ANAHTAR KELĠMELER: Kayma dayanımı, Kayma modülü, Rijit köpük, Üç ray 

kayma deneyi 

JÜRĠ: Doç. Dr. Ġzzet Ufuk ÇAĞDAġ 

 Prof. Dr. Mehmet Emin KARA 

 Dr. Öğr. Üyesi Rıfat TÜR 
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ABSTRACT 

DETERMINATION OF SHEAR PARAMETERS OF RIGID FOAMS WITH 

THREE RAĠL SHEAR TEST 

Tuğçe SARGIN 

MSc. Thesis in Department of Civil Engineering 

Supervisor: Assoc. Prof. Dr. Ġzzet Ufuk ÇAĞDAġ 

May 2018; 46 pages 

In order to better understand the structural behavior of sandwich structures and 

to increase their performance, the shear modulus and shear strength values of the core 

materials used have to be determined accurately. Therefore in this study, the shear 

modulus and shear strength values of a lightweight polystyrene foam (PF) core material 

in the relevant material planes are obtained by performing three rail shear test (TRST). 

First, a rigid TRST apparatus had been manufactured. A total of 6 experiments 

had been performed; 3 for the strong plane and 3 for the weak plane. Using the 

experimental results obtained, the shear module of the PF core material are 

approximately calculated using the numerical and analytical models. ANSYS program  

is used for the numerical model and the classical beam theory is used for the analytical 

model, where shear deformation is also considered. 

The results obtained in this study show that TRST may be used to obtain the 

shear module but it should not be used to obtain the shear strength as the shear strength 

values obtained using this test are grossly in error. 

KEYWORDS: Rigid foam, Shear modulus, Shear strength, Three rail shear test. 

COMMITTEE: Assoc. Prof. Dr. Ġzzet Ufuk ÇAĞDAġ 

  Prof. Dr. Mehmet Emin KARA 
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1. GĠRĠġ 

Sandviç paneller hafiflik, hızlı montaj, ısı yalıtımı, yüksek mukavemet, az 

maliyet vb. birçok avantaja sahiptir. Bu nedenle, ülkemizde sandviç panel kullanımı 

özellikle yapı inĢaatında giderek yaygınlaĢmaktadır. 

Sandviç yapısının performansını en üst düzeye çıkarmak ve yük taĢıma 

kapasitesini tam olarak kullanmak için, çekirdeğin kesme davranıĢını tam olarak 

anlamak gerekir (Mostafa vd. 2013c). Bu nedenle bu çalıĢmada, piyasadan temin 

edilmiĢ bir polistren köpük (PK) malzemenin kayma modülü ve kayma dayanımı 

değerleri ilgili malzeme düzlemleri için elde edilmiĢtir. 

Isı yalıtımı, yüksek mekanik dayanım vb. sahip olduğu özelliklerinden ve yaygın 

olarak kullanılan bir malzeme olmasından dolayı sandviç panellerde genelde çekirdek 

malzemesi olarak PK kullanılmaktadır. Bu nedenle bu çalıĢmada test edilecek çekirdek 

malzemesi olarak PK seçilmiĢtir. 

Sandviç panel düzlemlerine dik etkiyen dıĢ yükler, çekirdek malzemesinde 

özellikle kayma gerilmesi oluĢturur ve kesme kuvvetinin neredeyse tamamını çekirdek 

taĢıyacaktır. Çekirdek, atalet momentini artırarak yüksek eğilme rijitliği sağlamasının 

yanı sıra çekmeye maruz dıĢ yüzey ile basınca maruz dıĢ yüzey arasındaki kesmenin 

iletilmesi için kritik önem taĢır (Mostafa vd. 2013c).  

Çekirdeğin malzeme parametreleri genellikle dıĢ plakaların parametrelerinden 

daha büyük sapmalar sergiler (Chuda-Kowalska 2010). Bu parametreler, plakanın yer 

değiĢtirmelerini çok etkiler ve sıkıĢtırılmıĢ dıĢ plakanın yerel stabilitesinde (buruĢma) 

belirleyici rol oynarlar (Chuda-Kowalska 2010). Bu yüzden çekirdek malzemesinin 

mekanik özellikleri tasarım ve kalite kontrol için önemlidir. 

Sandviç yapıların genellikle çekirdeğin kesilmesi veya çekirdek-dıĢ yüz 

ayrıĢması sebebi ile göçtükleri gözlemlenmiĢtir (Mostafa vd. 2013c). Ancak, yaygın 

olan göçme türü çekirdeğin kesilmesidir (Gdoutos 2002). Bu sebeple, çekirdek 

malzemesinin kayma dayanımının hassas olarak belirlenmesi gerekir. Panelin kayma 

dayanımını ise çekirdeğin kayma dayanımı belirlemektedir. Çekirdek, düĢük kayma 

dayanımına sahipse çekirdeğin kusuru ani olabilir (Mostafa vd. 2013c). Öte yandan 

çekirdek, yüksek kayma dayanımına sahipse çekirdek ile dıĢ yüzey plakaları arasındaki 

yapıĢma baĢarısız olabilir (Mostafa vd. 2013c). 

Sandviç panellerde kayma gerilmelerine bağlı deplasman, eğilmeye bağlı 

deplasmandan çok daha fazladır. Kayma gerilmelerine bağlı deplasman ise neredeyse 

tamamen çekirdeğin kayma modülüne bağlıdır. Kayma modülü ayrıca panel geniĢliği ve 

derinliği gibi sandviç paneller ile ilgili önemli tasarım parametrelerinin belirlenmesinde 

de çok önemli bir rol oynar. 

Yukarıdaki paragraflarda bahsedilen nedenlerden dolayı çekirdek malzemesinin 

kayma parametrelerinin belirlenmesi çok önemlidir. Bu nedenle bu çalıĢmada çekirdek 

malzemesinin kayma modül ve dayanım değerlerinin deneysel, analitik ve sayısal 

yöntemler ile belirlenmesi konusu incelenmiĢtir. Elde edilen sonuçlar, göz önünde 

bulundurulan malzemenin literatürde bulunan değerler ile karĢılaĢtırılmıĢtır. 
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Bu çalıĢmada, PK çekirdek malzemesinin kayma modülleri ve dayanım 

değerlerini belirlemek için, basitliği, eksantrik yükten kaynaklanan istenmeyen 

deformasyonu ortadan kaldırması, gerilme dağılımının saf kaymaya yakın olacağının 

tahmin edilmesi gibi sebeplerden dolayı üç ray kayma deneyi (ÜRKD) seçilmiĢtir. 

Öncelikle, kullanılan köpük çekirdek malzemesi için her üç malzeme ekseni 

düzleminde elastisite modülü ve basınç dayanımı değerleri belirlenmiĢtir. Rijit köpüğün 

malzeme özellikleri, içeriğindeki kimyasal bileĢenlere, karıĢtırma metoduna (el karıĢımı 

veya makine karıĢımı), ve hücre yapısına bağlıdır (Hakmi 1988). Bu nedenle yapısal 

analiz gerçekleĢtirilmeden önce çekirdek malzemesi mekanik özellikleri belirlenmelidir. 

Daha sonra, rijit bir ÜRKD düzeneği imal edilmiĢtir. Üçü kuvvetli düzlem ve 

üçü zayıf düzlem için olmak üzere, toplam altı adet deney yapılmıĢtır. Deneylerden elde 

edilen yük-deplasman eğrilerinin doğrusal kısımları kullanılarak sayısal ve analitik 

modeller vasıtasıyla PK çekirdek malzemesinin kayma modülü değerleri yaklaĢık olarak 

hesaplanmıĢtır. Sayısal model, ANSYS programı kullanılarak oluĢturulmuĢ ve 

karĢılaĢtırma maksadıyla kullanılmıĢ olan analitik model için de kayma 

deformasyonunun dahil edildiği klasik kiriĢ teorisinden faydalanılmıĢtır. 
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2. KAYNAK TARAMASI 

Rijit köpüklerin kayma parametreleri, ASTM C273 (BS 4370, DIN 53427 ve 

ISO 1922), ASTM C393 ve EN 12090 standartlarına uygun kayma deneyleri 

uygulanarak elde edilebilir. 

ASTM C393 standartına göre kayma modülü, üç veya dört nokta yükleme maruz 

bırakılan sandviç kiriĢ numuneleri ile yaklaĢık olarak elde edilebilir. Dört nokta 

yükleme deneyi, Hakmi (1988) ve Mäkeläinen ve Holmijoki (1983) tarafından 

kullanılmıĢtır.  

Çekirdek kayma dayanımı ve kayma modülünün, sandviç yapı tasarımı üzerinde 

yapılan çalıĢmalarda yaygın olarak kullanılan deney yöntemi ASTM C273 ile en iyi 

Ģekilde belirlendiği ASTM C393’de belirtilmiĢtir. Ayrıca Mitra (2010)’da ve Mostafa 

vd. (2013a, b, c)’de de bu belirtilmiĢtir. ASTM C273'e göre, rijit köpüklerin kayma 

özellikleri, 50 mm'den daha az olmayan bir geniĢliğe sahip olan ve uzunluk/kalınlık 

oranı 12'den yüksek olan ince numunelerin iki karĢıt yüzüne rijit bağlanan çelik 

plakalara zıt düzlemde uygulanan çekme gerilmesi veya basınç (çift ray kayma deneyi) 

ile elde edilebilir. Bu yüksek uzunluk/kalınlık oranının kullanılmasının gerilme 

yığılmalarını azalttığı ASTM C273'de belirtilmiĢtir. Bununla birlikte Hakmi (1988) ve 

Tajbakhsh (1992), yükleme çizgisinin çelik plakaların karĢı köĢelerinden geçmesi 

gerektiğini belirtmiĢlerdir. BS 4370, DIN 53427 ve ISO 1922’ye göre çift ray kayma 

deneyinde ise yükleme çizgisinin, numunenin merkez çizgisinden geçmesi gerektiği 

belirtilmiĢtir. Ayrıca Mäkeläinen ve Holmijoki (1983) tarafından sunulan grafiklerde 

çekirdeğin farklı türleri için farklı laboratuvarlardan ISO standartına göre yapılan çift 

ray kayma deneyleri arasında iyi bir uyuĢma olduğu görülmüĢtür (Hakmi 1988). O 

yüzden Hakmi (1988) ve Tajbakhsh (1992) çift ray kayma deneyini kalite kontrol 

deneyi olarak tavsiye etmiĢtir. Bu yönteme benzer ray kayma deneyi Daniel ve Cho 

(2011) tarafından da kullanılmıĢtır. Bununla birlikte Grédiac ve Dufort (2002) ve 

Yoshihara vd. (2016), Deney yöntemi ASTM C273’de ortaya çıkan olumsuz etkileri 

araĢtırmıĢlar ve deney sırasında çekirdek malzemede saf kayma halinin bulunmadığını 

belirtmiĢlerdir. O'Connor (1989)’da sandviç çekirdeklerin kayma özellikleri için ASTM 

C273 ve BS 4370 deneyleri eleĢtirel olarak incelenmiĢtir. 

Standart EN 12090'da tanımlanan 3 ray kayma deneyi (ÜRKD) de bazı 

çalıĢmalarda kullanılmıĢtır (Kilar vd. 2014;Wada vd. 2013). Kilar vd. (2014)’de bina 

altında ısı yalıtım tabakası olarak kullanılacak olan ekstrüde polistren malzemesinin 

ÜRKD ile monoton (değiĢmeyen) kesme yükleme deneyleri ve döngüsel kesme 

yükleme deneyleri yapılmıĢtır. Wada vd. (2013)’de ÜRKD ile çekirdek uzunluğunu ve 

çekirdek kalınlığı değiĢtirilerek çekirdek malzemesinin geometrisinin, üst tabaka 

malzemenin ve yükleme hızının kayma modülüne etkisi araĢtırılmıĢtır. Bununla birlikte 

Wada vd. (2013), bu yöntemle eksantrik yükün etkisi ortadan kaldırıldığını 

belirtmiĢlerdir ve ÜRKD sırasında önemli eğilmelerin meydana geldiğini 

göstermiĢlerdir. Ayrıca Davies (2001) tarafından bildirildiğine göre; Jungbluth ve 

Berner (1986) ve Hakmi (1988) tarafından bildirildiğine göre; Basu (1976) ÜRKD’nin, 

tam saf kayma olmaması nedeniyle düĢük kayma modülü değerleri verdiğini 

belirtmiĢlerdir. 
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Literatürde alternatif ve standartlaĢmıĢ olmayan deney yöntemleri de 

bulunmaktadır. Yoshihara vd. (2016), XPS’nin elastisite modülünü ve kayma modülünü 

belirlemek için numuneler üzerinde uzunlamasına ve eğilmeli titreĢim yöntemleri 

geliĢtirmiĢlerdir. Benzer bir titreĢim deneyi tanımlanmıĢtır ve diğer deney yöntemleri ile 

karĢılaĢtırma Hakmi (1988) tarafından bildirildiğine göre; Basu (1976) tarafından 

yapılmıĢ ve titreĢim çok kısa olduğu için önerilen titreĢim deneyinin en yüksek kayma 

modülü değerini verdiği gösterilmiĢtir. 

Penzien ve Didriksson (1964), "4 mafsallı çerçeve kayma deneyi" 

geliĢtirmiĢlerdir. Bu deney farklı çekirdek malzemeleri için Basu (1976), Davies (2001), 

Hakmi (1988) ve Tajbakhsh (1992) tarafından kullanılmıĢtır. Hakmi (1988), köĢelerdeki 

yerel baĢarısızlığı (kusuru) önlemek için çekme kuvvetleri yerine basınç kuvvetleri 

uygulamanın daha iyi olacağını ve basınç yükleri iki köĢegen karĢıt köĢesinden geçen 

kendi hareket çizgileriyle uygulandığında çekirdeğin saf kayma deformasyonu elde 

edildiğini bulmuĢtur. Ayrıca bu deney yöntemi için Hakmi (1988) tarafından 

bildirildiğine göre; Basu (1976) saf kaymanın yalnızca deneyin baĢlangıcında olduğunu 

belirtmiĢtir yani gerilmenin küçük değerleri için çekirdeğin gerçek kayma özelliklerini 

verdiğini belirtmiĢtir. Bu nedenle 4 mafsallı çerçeve kayma deneyi yöntemi yaygın 

olarak kullanılmamaktadır. 

Kayma modülünü elde etmek için burulma deneyi de düĢünülmüĢtür (Roy ve 

Camping 2003; Chuda-Kowalska vd. 2010). Ancak silindirik numuneler 

gerektirmesinden ötürü burulma testi yaygın olarak kullanılmamaktadır. 

Gdoutos vd. (2002), ASTM C273’ün kusurlarını ortadan kaldıran Iosipescu 

deney bağlantı düzeneğine benzer Arcan deney düzeneği olarak adlandırılan bir deney 

düzeneği kullanmıĢtır. Ancak çentikler etrafında gerilme yığılmaları oluĢacağından, bu 

testin iyi netice vermeyeceği değerlendirilmektedir. 

Hücresel malzemelerin kayma modülünü elde etmek için yardımcı olabilecek 

mikromekanik yaklaĢımlar yapılmıĢtır (Subramanian ve Sankar 2012). 

Yukarıda bahsedilen deney yöntemlerine göre basitliği, eksantrik yükten 

kaynaklanan istenmeyen deformasyonu ortadan kaldırması, gerilme dağılımının saf 

kaymaya yakın olacağının tahmin edilmesi sebebi ile ÜRKD’nin kullanılmasının daha 

uygun olacağı görülmüĢtür. 

 



MATERYAL VE METOT                T. SARGIN 

5 

 

3. MATERYAL VE METOT 

3.1. Kullanılan Malzemeler 

Kullanılan polistren köpük (PK) malzemesi, 50 mm kalınlığında bir PK paneldir 

(model: Wallboard). 6 mm kalınlığında delikleri olan ahĢap plakalar kullanılmıĢtır. 

Kullanılan iki parçalı tutkal ġekil 3.1’de gösterilmiĢtir. 

 

 

 

 

 

 

ġekil 3.1. Kullanılan tutkal malzemesi 

 

Kullanılan tutkalın üretici firma tarafından verilmiĢ olan özellikleri aĢağıda 

verilmiĢtir: 

 Ağırlıkça 6 kısım poliüretan bazlı reçine (poliol) ve 1 kısım sertleĢtirici 

(katalizör) homojen ve tek bir renk olana kadar iyice karıĢtırılmalıdır.(1/6 

oranında) 

 Hazırlanan karıĢım 30 dakika içerisinde kullanılmalıdır. 

 Uygulanacak yüzey temiz, yağsız ve kuru olmalıdır. 

 KarıĢım tarakla veya spatula vasıtası ile yüzeye tatbik edilir. 

 Kuruma veya dokunabilme kürlenmesi süresi 5-7 saattir, ortam sıcaklığına bağlı 

olarak bu süre değiĢebilir. 

 Mekanik dayanıklılık 12-14 saat. 

 Kimyasal dayanıklılık 7 gün sonradır. 

 Kullanım miktarı 900-1200 gr/m
2
 (zeminin düzgünlüğüne göre değiĢebilir). 

 Reçine ve sertleĢtirici kısmı inceltilmez. Net:(A+B)=7 kg ürün ihtiva eder. 
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Çizelge 3.1. Kullanılan tutkal malzemesinin teknik özellikleri 

 

Sertlik 75-80 

Malzeme Yapısı 
Çift bileĢenli poliüretan reçine 

ve sertleĢtirici 

Bağlayıcı Madde Poliüretan reçine 

Yoğunluk 
Ana malzeme 1.60 gr/cm

3
 / 

sertleĢtirici 1.22 gr/cm
3
 

KarıĢım Oranı 6/1 kg ağırlıkça 

Uygulama Süresi ( 23 °C ) de 30 Dakika 

KatılaĢma BaĢlangıcı 
25 °C /+40 °C ısısında 45. 

Dakika 

Isı dayanıklılığı -40 °C/+280 °C 

Kürünü Tamamlama  ( 20 °C) 5-7 saat 

Çevreye uyum Çevreye olumsuz etkisi yok 

Sağlığa uygunluk Sağlığa zararlı değildir 

UV IĢınlarına UV dayanıklıdır 

 

3.2. Polistren Köpük Malzemesinin Basma Deneyleri 

PK malzemesine BS-EN826 standartına göre her üç malzeme düzlemi için 

yapılan basma deneyi ile bulunan -eğrileri ġekil 3.2’de ve mekanik özellikleri 

Çizelge 3.2’de verilmiĢtir. 

 

 

 

 

 

 

 

 

 

ġekil 3.2. Üç yönde yapılan basma deneyi ile bulunan polistren köpüğün gerilme-birim 

Ģekil değiĢtirme eğrileri (Cagdas ve Taskin 2018) 
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Çizelge 3.2. Polistren köpük malzemesinin mekanik özellikleri (Cagdas ve Taskin 

2018) 

 

Mekanik 

Özellik 
Tanım Değer 

 (kg/m
3
) Yoğunluk 23.40 

XPSE1  (MPa) 
1 (köpük yükselme) yönündeki elastisite 

modülü 
6.33 

XPSE2  (Mpa) 2 yönündeki elastisite modülü 4.41 

XPSE3  (Mpa) 3 yönündeki elastisite modülü 2.40 

XPS

CX 1,  (Mpa) 1 yönündeki basınç dayanımı 0.19 

XPS

CX 2,  (Mpa) 2 yönündeki basınç dayanımı 0.11 

XPS

CX 3,  (Mpa) 3 yönündeki basınç dayanımı 0.07 

12

XPSG  (Mpa) 1-2 düzlemi için kayma modülü 4.32 

23

XPSG  (Mpa) 2-3 düzlemi için kayma modülü 3.31 

12

XPSS  1-2 düzlemi için kayma dayanımı 0.16 

23

XPSS  2-3 düzlemi için kayma dayanımı 0.10 

 

3.3. Deneysel ÇalıĢma 

Bu çalıĢmada, PK çekirdek malzemesinin kayma modülü ve kayma dayanımı 

değerlerini bulmak için üç ray kayma deneyi (ÜRKD) kullanılmıĢtır. ġekil 3.3’te kayma 

deneyi Ģematik olarak gösterilmektedir. 
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ġekil 3.3. Kayma deneyinin Ģematik görünüĢü a) Deneyin ön görünüĢü; b) A-A kesiti; 

c) B-B kesiti 
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3.3.1. Üç ray kayma deneyi kurulumu 

Deneyde kullanılan deplasman kontrollü elektromekanik deney makinesine 

(model: RANTEK-100) uygun, ġekil 3.4'te gösterilen rijit bir çelik çerçeve 

oluĢturulmuĢtur. Çerçevenin en dıĢtaki çelik plakaları, deney makinesinin üzerine 

dayanan bir taban profiline kutu profillerle kaynak yaptırılarak tutturulmuĢtur. Daha 

sonra farklı numune boyutuna göre ayarlanabilmesi ve numunelerin yük uygulanmayan 

dıĢ kısımlarında büyük eğilme deformasyonları oluĢmaması için en dıĢtaki çelik 

plakalara tijle bağlanmıĢ çelik plaka çifti yerleĢtirilmiĢtir. Bu yerleĢtirilen çelik plakalar 

ve en dıĢtaki çelik plakalar birbirine tek tijle bağlanmıĢtır. Bu sayede deney 

düzeneğinde, tutturma sisteminin gerçek davranıĢları yansıtılmıĢtır. En içte merkezdeki 

çelik plakalar ise tijle çerçevenin üstündeki yük hücresine monte edilmiĢtir. 100 kN 

kapasiteli bir yük hücresi (model: Puls Elektronik HT1-W) ve 0.01 mm doğruluk ve 100 

mm hareket değerine sahip doğrusal bir potansiyometrik cetvel (model: Opkon), 8 

kanallı veri kaydediciye (model: TESTART-Testbox 1001) bağlanmıĢtır. Yükleme hızı, 

atalet etkilerini ortadan kaldırmak için 2.2 mm / dk olarak seçilmiĢtir. 

 

 

ġekil 3.4. Deney kurulumu 

3.3.2. Numunelerin üretimi ve deney düzeneğine yerleĢtirilmesi 

Kalınlık yönü, PK kartı için köpük yükselme yönüdür. Numuneler, bc=50 mm ve 

hc=50 mm olacak Ģekilde numunelerin zarar görmesini önlemek amacıyla ġekil 3.5'te 

gösterildiği gibi bir sıcak tel kesici kullanılarak kesilmiĢtir. Sonra bu kübik numunelerin 

deney çerçevesine bağlanması için ġekil 3.6'daki gibi PK'yı eritmeyen bir poliüretan 

esaslı yapıĢtırıcıyla deliklere sahip ahĢap plakalara yapıĢtırılmıĢtır ve çelik çubuklarla 

sabitlenmesi sağlanmıĢır. Kürünü aldıktan sonra bu numuneler tijlerle deney 

çerçevesine bağlanmıĢtır. Böylece içteki çelik plakadan (raydan) ahĢap plaka’ya 

aktarılan basınç yükü, sürtünme ile kesme kuvveti olarak PK’ya aktarılmıĢtır.  

 

 

 

 

ġekil 3.5. Sıcak tel kesici 
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ġekil 3.6. Numunenin hazırlanması 

3.3.3. Üç ray kayma deneyinin yapılması 

Orta çifte basınç uygulanmıĢtır. Yük hücresi ve dönüĢtürücüler vasıtasıyla 

uygulanan basınç yükü (P) ve yüzeyler arasındaki bağıl deplasman () ölçülmüĢtür. 

Ölçülen deney verileri 0.125 s (125 ms) zaman aralığında TestLAB Basic statik veri 

toplama yazılımı aracılığıyla kiĢisel bir bilgisayara kaydedilmiĢtir. bc=50 mm ve hc=50 

mm olan kübik PK numuneleri üzerinde üçü kuvvetli ve üçü zayıf düzlem (sırasıyla 1-2 

ve 2-3 düzlemi) için olmak üzere toplam altı deney yapılmıĢtır. Yük-deplasman verileri 

orantılı olup G12 değeri G13 değerine yakın olduğundan 1-3 düzleminde deney 

yapılmamıĢtır. 

3.4. Sayısal Modellemelerin Yapılması 

Sonlu elemanlar analizi belirli yüklere maruz kalan fiziksel problemi, 

matematiksel probleme dönüĢtürerek çözer (Bathe 2016). Doğruluk ölçütleri 

karĢılanmazsa yeterli doğruluk ulaĢana kadar değiĢtirilmiĢ çözüm parametreleriyle 

(mesela daha fazla eleman kullanarak) tekrarlar (Bathe 2016). 

Sonlu elemanlar analizi için “Ansys Workbench Free Student Product” programı 

kullanılmıĢtır. Test edilen numuneler simetrik olduğundan, sonlu elemanlar analizinde 

bir numune modellenmiĢtir. Deneyden elde edilen P- eğrilerinin doğrusal kısımları 

kullanılarak sayısal modelden zayıf ve kuvvetli düzlemlerdeki kayma modülleri 

hesaplanmıĢtır. 

3.5. Analitik Çözüm Bulunması 

Wada vd. (2013)’de de yararlanılmıĢ olan ve basitliğinden dolayı seçilen kiriĢ 

teorisinden yararlanılarak PK’nın kayma modülleri hesaplanmaya çalıĢılmıĢtır. 

Çekirdeğin deformasyonu, ġekil 3.7'de Ģematik olarak gösterildiği gibi eğilme 

deformasyonu (b) ve kayma deformasyonunun (s) toplamı olacaktır, ancak bu Ģekil 

kalınlık yönünde abartılmıĢtır. 
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ġekil 3.7. Çekirdeğin eğilme, kesme ve toplam deformasyonlarının Ģematik görünüĢü 

 

 

 

 

 

 

 

ġekil 3.8. Numuneye etkiyen uç eğilme momentleri ve kesme kuvvetleri 

ġekil 3.8’de gösterildiği gibi bulunan kesme kuvveti formülünden eğilme 

deformasyonu çekildiğinde aĢağıdaki (3.1)’deki formül elde edilmiĢtir: 

3

012

c
b

c c

Pt

E I
                                                                    (3.1) 

Burada P yük, tc çekirdek kalınlığı, Ec0 elastisite modülü ve Ic atalet momentidir. 
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12

3

cc
c

Lt
I                                                                          (3.2) 

Lc, çekirdek malzemesinin uzunluğudur. 

Kayma deformasyonu (s) aĢağıdaki formülden bulunur: 

0ccc

c
s

GLb

Pt
                                                                   (3.3) 

bc, çekirdek malzemesinin geniĢliği ve Gc0 ise kayma modülüdür. 

Toplam deformasyon ise aĢağıdaki formülden bulunur: 

                                   sb                                                                      (3.4) 

Deneyden elde edilen P- eğrilerinin doğrusal kısımları kullanılarak analitik 

modelden zayıf ve kuvvetli düzlemlerdeki kayma modülleri hesaplanmıĢtır. 
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4. BULGULAR VE TARTIġMA 

Polistren köpüğün (PK) kayma modülleri, üç ray kayma deneyinden (ÜRKD) 

bulunan P- eğrileri kullanılarak ANSYS programı ve kiriĢ teorisi vasıtasıyla 

hesaplanmıĢtır. PK’nın kayma dayanımları ise deneyden yaklaĢık olarak bulunmuĢtur. 

4.1. Üç Ray Kayma Deneyi Sonuçlarından Kayma Modüllerinin ve Kayma 

Dayanımlarının Hesaplanması 

AĢağıdaki ġekil 4.1’de gösterildiği gibi deney sonucunda iki numuneye de 

etkiyen toplam yük (P) ve numunelerin en içte merkezdeki çelik plakalara bağlanmıĢ 

taraflarında alt uçlarındaki deplasman ( ) değerleri ölçülmüĢtür. 

 

 

 

 

 

 

 

 

ġekil 4.1. Deforme olmuĢ numunelerin Ģematik görünümü 

Deney sonucunda ölçülen yük-deplasman eğrileri aĢağıda sunulmuĢtur. Grafikte 

her bir numune çiftinden kayma modülleri yüksek olanlar çizdirilmiĢtir. 

(a)            (b) 

 

ġekil 4.2. a) Zayıf düzlemde test edilen numunelerin P- eğrileri; b) Kuvvetli 

düzlemde test edilen numunelerin P- eğrileri 
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Zayıf düzlemde test edilen numunelerde ortalama 250 N’a kadar neredeyse 

doğrusallık bozulmadan yük-deplasman değerleri artmıĢtır ve bu yük değeri için  1.2 

mm’dir. Kuvvetli düzlemde test edilen numunelerde de bir numune çifti hariç ortalama 

262 N’a kadar neredeyse doğrusallık bozulmadan yük-deplasman değerleri artmıĢtır ve 

ortalama 1.2 mm’dir. BaĢarısız olan numune çiftinin baĢarısızlığı numune 

üretiminden kaynaklı olabilir. Zayıf düzlemde test edilen numuneler biraz daha sünek 

davranmıĢtır (ġekil 4.2 a). 

(a)        (b) 

 

ġekil 4.3. Zayıf düzlemde test edilen üçüncü numunenin a) deney öncesindeki 

görüntüsü; b) deney sonundaki deforme olmuĢ görüntüsü 

(a)            (b) 

 

ġekil 4.4. Kuvvetli düzlemde test edilen üçüncü numunenin a) deney öncesindeki 

görüntüsü; b) deney sonundaki deforme olmuĢ görüntüsü 
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Benzer sonuçlar gösterdiğinden kuvvetli ve zayıf yönde test edilen 

numunelerden bir tanesinin görüntüleri sunulmuĢtur. Deney sırasında, numunelerin yan 

yüzeylerinin birinde düĢey yönde çatlakların oluĢmasından sonra yük seviyesinde ani 

azalma gözlemlenmiĢtir. Ayrıca numunede saf kayma durumu olmadığı anlaĢılmıĢtır. 

Bulunan yük-deplasman eğrileri, aĢağıda verilen (4.1) ve (4.2) formülleriyle 

ġekil 4.5’deki kayma gerilmesi ()-kayma birim Ģekil değiĢtirmesi () eğrilerine 

dönüĢtürülmüĢtür: 

                                               
2 c c

V P

A L b

    (4.1) 

Burada  kayma gerilmesi, V kesme kuvveti ve A kesit alanıdır. Ayrıca P, Lc ve 

bc sırasıyla toplam yük, çekirdek malzemesinin uzunluğu ve geniĢliğidir. 

                                                
ct


   (4.2) 

kayma birim Ģekil değiĢtirmesi,  deplasman ve tc ise çekirdek kalınlığıdır. 

Bulunan kayma gerilmesi-kayma birim Ģekil değiĢtirmesi eğrileri aĢağıda 

sunulmuĢtur: 

(a)      (b) 

 

ġekil 4.5.a) Zayıf düzlemde test edilen numunelerin - eğrileri; b) Kuvvetli düzlemde 

test edilen numunelerin - eğrileri 

                                                



cG  (4.3) 
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y = 2,2682x + 0,0015

0
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0,02
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0,08

0 0,01 0,02 0,03 0,04 0,05 0,06 0,07 0,08


(N

/m
m

2
)



z_2

0.005-0.01 arası

Doğrusal (0.005-0.01

arası)

Çekirdeğin kayma modülü, (4.3) formülünden görüldüğü gibi kayma gerilmesi 

()-kayma birim Ģekil değiĢtirmesi () eğrisinin elastik bölgedeki lineer kısmının 

eğiminden bulunabilir. - eğrisinin baĢlangıç kısmında numunenin ezilmesinden 

kaynaklı nonlineer davranıĢ olabileceğinden dolayı burada kayma modülü değerleri, 

=0.005 ile 0.01 arasındaki kayma gerilmesi-kayma birim Ģekil değiĢtirmesi eğrilerine 

eğri uydurma yöntemiyle eğimden bulunmuĢtur. 

 

 

 

 

 

 

 

 

 

ġekil 4.6. Zayıf yönde test edilen ikinci numunenin kayma gerilmesi-kayma birim Ģekil 

değiĢtirmesi eğrisinden eğri uydurma yöntemiyle kayma modülünün bulunması 

Test edilen zayıf yöndeki numune için çekirdeğin ortalama kayma modülü 2.18 

MPa bulunmuĢtur. Test edilen kuvvetli yöndeki numune için çekirdeğin ortalama 

kayma modülü ise 2.19 MPa bulunmuĢtur.  

Kayma dayanımı, malzemenin kalıcı deformasyon olmadan veya kopmadan 

önce taĢıyabileceği maksimum kayma gerilmesidir. Test edilen zayıf yöndeki numune 

için çekirdeğin kayma dayanımı 0.07 MPa bulunmuĢtur. Test edilen kuvvetli yöndeki 

numune için çekirdeğin kayma dayanımı ise 0.07 MPa bulunmuĢtur. Ancak sayısal 

modelden de görüleceği gibi kayma gerilmesi dağılımlarının uniform olmamasından ve 

numune köĢelerinde gerilme yığılmalarının meydana gelmesinden dolayı bu deneysel 

olarak elde edilen kayma dayanımı değerleri yaklaĢık değerlerdir. 

4.2. Ansys Workbench Programıyla Kayma Modüllerinin Bulunması 

Kuvvetli ve zayıf yönde test edilen numune, ANSYS programında düzlem 

gerilme elemanı olarak ayrı ayrı modellenmiĢtir. 
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4.2.1. Kuvvetli yöndeki numunenin modellenmesi 

 

 

 

 

 

 

 

ġekil 4.7. Kuvvetli yönde modellenecek sonlu eleman modeli 

Yukarıdaki ġekil 4.7’de gösterilen model tanımlanmıĢtır. Malzeme simetrisi 

olduğundan Ansys Workbench’te Static Structural > Engineering Data’da çekirdek 

malzemesi ortotrop malzeme olarak aĢağıdaki ġekil 4.8’de gösterildiği gibi malzeme 

girdileri girilmiĢtir. 

 

ġekil 4.8. Ansys Workbench’e malzeme özelliklerinin girilmesi 

Elastisite modülleri, basma deneyi ile bulunan - eğrisinden hesaplanmıĢtır. 

Girilen kayma modülü değerleri de ÜRKD ile bulunan sonuçlardır. Ancak amaç 

deneyden bulunan P-değerlerine uydurarak kayma modüllerini bulmak olduğundan 

daha sonra kayma modülü değerleri değiĢtirilmiĢtir. Poisson oranı etkisi, elastisite 

modülü ve kayma modülünü belirlemede önemli değildir (Yoshihara vd. 2016). O 

yüzden Gdoutos vd. (2002) tarafından yapılmıĢ bir çalıĢma referans alınarak Poisson 

oranı 0.35 alınmıĢtır. 
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Static Structural > Geometry (sağ tuĢ) >Properties’den sağ tarafta açılan 

Properties Of Schematic A3: Geometry’den Advanced Geometry Options sekmesi 

altındaki Analysis Type 2D yapılmıĢtır. 

 

 

 

 

 

 

 

 

 

ġekil 4.9. Ansys Workbench’de analiz tipinin iki boyutlu yapılması 

Static Structural > Geometry’de sırayla geometri daha sonra ise yüzey 

oluĢturulmuĢtur. 

 

ġekil 4.10. Ansys Workbench’de modelin geometrisinin oluĢturulması ve ardından 

yüzey yapılması 
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Static Structural > Model’den Mechanical sayfası açıldıktan sonra Outline 

kısmındaki Project > Model (A4) > Geometry’e tıklanıp sağ alt kısımda ekrana gelen 

Details of Geometry > Definition > 2D Behavior’da (iki boyutlu davranıĢ) Plane 

Stress’in (düzlem gerilme) seçili olduğuna dikkat edilmelidir. 

 

ġekil 4.11. Ansys Workbench’de düzlem gerilme elemanının seçili olmasına bakılması 

Kalınlık değerinin girilmesi için Surface Body’e tıklanarak ekrana gelen sol alt 

kısımdaki Details of Surface Body > Definition sekmesi altındaki Thickness’a değer 

girilmiĢtir. 

 

ġekil 4.12. Ansys Workbench’de modellenen elemana kalınlık değerinin girilmesi 

OluĢturulan modelin malzeme atamasını yapmak için yine Details of Surface 

Body > Material altındaki Assignment’ta ok iĢaretine basılarak tanımlanmıĢ olan 

malzeme seçilmiĢtir.  
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ġekil 4.13. Ansys Workbench’de oluĢturulan modelin malzeme atamasının yapılması 

Analizde yüksek doğruluğu nedeniyle mesh sekmesinde 4x4 mesh 8 düğümlü 

izoparametrik ikinci dereceden dörtgen düzlem gerilme sonlu elemanı tanımlanmıĢtır. 

Modellemede kullanılan sonlu elemanların ayrıntılı formülasyonu Bathe (2016)’da 

bulunabilir. 

 

ġekil 4.14. Ansys Workbench’de oluĢturulan modele 4x4 8 düğümlü mesh 

tanımlanması 

Outline penceresinin altındaki Static Structural’a fare ile sağ tuĢ yapılarak Insert 

> Fixed Support ve Insert > Displacement’ten modelin ilgili kenarlarına sırasıyla sabit 

mesnet ve hareketli mesnet (x component=0 ve y component=free) tanımlanmıĢtır. 

Kuvvet tanımlanmadan önce, deneydeki yükün okunduğu zaman değerlerini 

girmek için Details of Analysis Settings’de Step End Time’a (adım bitiĢ zamanı) zaman 

değerlerinden daha büyük bir sayı değeri ġekil 4.15’de görüldüğü gibi girilmiĢtir. 

Ardından yine ġekil 4.15’de görüldüğü gibi Number of Steps yani toplam yük adım 

sayısına deneyde okunan adım sayısı girilmiĢtir. Sağ tarafta yer alan Tabular Data’ya 

(tablo verisine) zaman değerleri kopyalanılmıĢtır. Lineer ve nonlineer analiz, küçük yer 

değiĢtirmeler için benzer sonuçlar verdiğinden kayma modülünün bulunması için lineer 

analiz yapılmıĢtır. Lineer analiz yapıldığından diğer analiz ayarlarında değiĢiklik 
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yapılmamıĢtır. 

 

ġekil 4.15. Ansys Workbench’de toplam yük adım sayısının ve deneyde yük değeri 

okunan zaman değerlerinin girilmesi. 

Insert > Force’dan kuvvet tanımlanmıĢtır. Details of Force’da ġekil 4.16’da 

görüldüğü gibi yükün uygulandığı köĢe noktası ve yükün yönü seçilmiĢtir. Ayrıca sağ 

tarafta yer alan Tabular Data’ya deneyden bulunan yük değerlerinin yarısı 

kopyalanılmıĢtır. Çünkü deneyden bulunulan yük değerleri iki numuneye etkiyen 

toplam yük olduğu için sayısal modelde yarısı alınmıĢtır. 

 

ġekil 4.16. Ansys Workbench’de kuvvet tanımlama ve deneyde okunan yük 

değerlerinin kuvvet olarak girilmesi. 



BULGULAR VE TARTIġMA                T. SARGIN 

22 

 

 

ġekil 4.17. Ansys Workbench’de oluĢturulan modele atanan sınır Ģartlarının ve kuvvetin 

görüntülenmesi. 

Çözüm yapılmadan önce Solution kısmında Solution (sağ tuĢ) > Insert > 

Deformation > Directional seçilmiĢtir. Sol alt kısımda yer alan Details of Directional 

Deformation’da Geometry, yukarıdaki üst menüden Vertex/Node tıklanılarak 

deformasyonun okunacağı hareketli mesnet tanımlı kenarın alt ucu cisim üzerinde 

seçilmiĢtir ve Apply’den kabul edilmiĢtir. Ayrıca Orientation’da Y Axis seçilmiĢtir. 

 

ġekil 4.18. Ansys Workbench’de oluĢturulan modelde analiz yapılmadan önce istenilen 

çözümün eklenmesi. 
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Solve komutuyla çözüm yaptırılmıĢtır. Analizden çıkan deformasyon değerleri 

aĢağıda gösterilmiĢtir: 

 

ġekil 4.19. Ansys Workbench’de analiz sonucunda modelin alt ucunda oluĢan 

deformasyonların görüntülenmesi.  

ġekil 4.19’da görüldüğü üzere sağ altta yer alan Tabular Data’daki analizden 

bulunan deformasyon değerleri kopyalanılıp ANSYS’de girilmiĢ olan yük-zaman 

değerlerine ait deneyden bulunan P-eğrisiyle excelde karĢılaĢtırılmıĢ ve = 0.25-0.5 

aralığında çakıĢmadığı görülmüĢtür. Sayısal model, düzlem gerilme elemanı olarak 

modellendiğinden kayma modüllerinden sadece x-y düzlemindeki kayma modülü, 

analiz sonucunu değiĢtirecektir. x-y düzlemindeki kayma modülü değiĢtirilerek, 

deneyden elde edilen P-eğrisine = 0.25-0.5mm aralığında çakıĢtırılmaya çalıĢılıp 

kayma modülü değeri bulunmaya çalıĢılmıĢtır. Ve bu diğer deney sonuçlarında da 

gerçekleĢtirilerek x-y (1-2) düzlemi yani kuvvetli yön için ortalama kayma modülü 

değeri yaklaĢık 2.75 MPa bulunmuĢtur. 

Ayrıca çözüme Solution (sağ tuĢ) > Insert > Normal Stress (Orientation X Axis) 

ve Solution (sağ tuĢ) > Insert > Shear Stress eklenilerek modelin üzerinde oluĢan normal 

gerilmelere ve kayma gerilmelerine bakılabilir. Sonlu elemanlar modelinde yükün sağ 

üst köĢe yerine sağ kenar boyunca yayılı olarak tatbik edilmesinin gerilme dağılımının 

daha doğru olarak elde edilebilmesi için daha uygun olacağı düĢünülmektedir. 
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ġekil 4.20. Ansys Workbench’de analizden çıkan modelin üzerinde oluĢan normal 

gerilmelerin görüntülenmesi. 

 

 

 

 

 

 

 

 

 

 

 

 

ġekil 4.21. Ansys Workbench’de analizden çıkan modelin üzerinde oluĢan kayma 

gerilmelerinin görüntülenmesi. 

Görüldüğü gibi yine numune köĢelerinde gerilme yığılmalarının meydana 

gelmesinden ve kayma gerilmesi dağılımlarının üniform olmamasından dolayı kayma 

dayanımları bulunmamıĢtır. 

4.2.2. Zayıf yöndeki numunenin modellenmesi 

 

 

 

 

 

 

ġekil 4.22. Zayıf yönde modellenecek sonlu eleman modeli. 
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ġekil 4.22’de gösterilen model tanımlanmıĢtır. Zayıf yöndeki numune y-z 

düzlemindedir. Ancak 2D analizde model, x-y düzleminde olmalıdır. O yüzden bu 

eksen değiĢikliği Engineering Data’da yansıtılmalıdır. Ama Engineering Data haricinde 

4.2.1’de oluĢturulan modelden farklı olmadığı için Duplicate seçilerek model girdileri 

kopyalanmıĢtır. 

Engineering Data’da aĢağıdaki Ģekilde görüldüğü gibi değerler değiĢtirilmiĢtir. 

 

 

 

 

 

 

 

ġekil 4.23. Ansys Workbench’de malzeme özelliklerinde elemanın düzlemine göre 

değiĢiklik yapılması. 

Modelde tanımlanacak olan girdiler kopyalandığı için direkt Model tıklanıp 

Solve ile çözdürülmüĢtür. 

Sayısal modelden bulunan P-eğrileri, deneyden bulunan P-eğrileriyle 

=0.25-0.5 aralığında çakıĢtırılmaya çalıĢılmıĢtır. Eksen değiĢikliği yapıldığı için yine 

kayma modüllerinden sadece x-y düzlemindeki kayma modülü, analiz sonucunu 

değiĢtirecektir. x-y (2-3) düzlemi yani zayıf yön için ortalama kayma modülü değeri 

2.52 MPa bulunmuĢtur. 

Yine analizden çıkan model üzerinde oluĢan normal gerilmeler ve kayma 

gerilmelerine bakılabilir: 

 

 

 

 

 

 

 

 

 

 

 

 

ġekil 4.24. Ansys Workbench’de analizden çıkan modelin üzerinde oluĢan normal 

gerilmelerin görüntülenmesi. 
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ġekil 4.25. Ansys Workbench’de analizden çıkan modelin üzerinde oluĢan kayma 

gerilmelerinin görüntülenmesi. 

 

ġekil 4.20 ve ġekil 4.24’de görüldüğü gibi normal gerilme dağılımında yükün 

uygulandığı sağ üst uçta ve sol alt uçta maksimum basınç gerilmeleri gözlemlenebilir. 

Ayrıca sol üst uçta ve sağ alt uçta ise maksimum çekme gerilmeleri oluĢtuğu 

gözlemlenebilir. ġekil 4.21 ve ġekil 4.25’de maksimum kayma gerilmelerinin, sol uçta 

oluĢtuğu gözlemlenebilir. 

Görüldüğü gibi yine numune köĢelerinde gerilme yığılmalarının meydana 

gelmesinden ve kayma gerilmesi dağılımlarının üniform olmamasından dolayı kayma 

dayanımları bulunmamıĢtır. Kuvvetli numunelerde de görüldüğü üzere, sonlu elemanlar 

modelinde yükün sağ üst köĢe yerine sağ kenar boyunca yayılı olarak tatbik edilmesinin 

gerilme dağılımının daha doğru olarak elde edilebilmesi için daha uygun olacağı 

düĢünülmektedir. 

4.3. Kayma Deformasyonunun Dahil Edildiği KiriĢ Teorisine Göre Kayma 

Modüllerinin Bulunması 

Kuvvetli ve zayıf yönde test edilen numunenin, kiriĢ teorisine göre ayrı ayrı 

kayma modülleri hesaplanmıĢtır. Deneysel ve sayısal model sonuçlarından görüldüğü 

üzere numune köĢelerinde gerilme yığılmalarının meydana gelmesinden dolayı analitik 

model ile kayma dayanımları bulunmamıĢtır. 

4.3.1. Kuvvetli yön için çekirdeğin kayma modülünü hesaplama 

Ġlk baĢta deneyde okuma alınan yüklerin yarısına göre bölüm 3.5’te verilmiĢ 

olan (3.1)-(3.4) formülleriyle deformasyonlar hesaplanmıĢtır. Çünkü deneyden 

bulunulan yük değerleri iki numuneye etkiyen toplam yük olduğu için analitik modelde 

yarısı alınmıĢtır. Kuvvetli yön için Ec0, eğilme etkisinden dolayı basınç deneyinden E1 

ve Gc0 ise 1-2 düzleminde olduğu için deneyden bulunan G12 alınmıĢtır. Yine burada da 

G12 değeri değiĢtirilerek analitik çözümden bulunan P- eğrileri, deneyden bulunan P- 

eğrileri ile = 0.25-0.5 mm aralığında çakıĢtırılıp kayma modülü bulunmaya 

çalıĢılmıĢtır. Kuvvetli yön için ortalama kayma modülü 4.14 MPa bulunmuĢtur. 
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4.3.2. Zayıf yön için çekirdeğin kayma modülünü hesaplama 

Deneyden okuma alınan yüklerin yarısına göre (3.1)-(3.4) formülleriyle 

deformasyonlar hesaplanmıĢtır. Ancak zayıf düzlem için Ec0, eğilme etkisinden dolayı 

basınç deneyinden E2 ve Gc0 ise 2-3 düzleminde olduğu için deneyden bulunan G23 

alınmıĢtır. G23 değiĢtirilerek analitik çözümden bulunan P- eğrileri, deneyden bulunan 

P- eğrileri ile = 0.25-0.5 aralığında çakıĢtırılarak zayıf yön için çekirdeğin ortalama 

kayma modülü 4.83 N/mm
2
 bulunmuĢtur. 
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5. SONUÇLAR 

Elde edilen sonuçlar Ģöyle özetlenebilir; 

 Yapılan üç ray kayma deneyleri (ÜRKD) numunelerde saf kayma hali 

olmadığını göstermiĢtir. 

 Elde edilen deneysel verilerden polistren köpük (PK) çekirdek malzemesinin 1-2 

düzlemi için PK malzemesinin ortalama kayma modülü yaklaĢık 2.19 MPa ve 

kayma dayanımı yaklaĢık 0.07 MPa olarak elde edilmiĢtir. 2-3 düzlemi için ise 

ortalama kayma modülü yaklaĢık 2.18 MPa ve kayma dayanımı yaklaĢık 0.07 

bulunmuĢtur. Deneysel neticeler, Çizelge 3.2’de verilen değerler ile 

kıyaslandığında ÜRKD’nin kayma parametreleri için çok düĢük değerler verdiği 

anlaĢılmıĢtır. 

 Deney neticeleri ANSYS sonlu elemanlar paket programı ile oluĢturulmuĢ olan 

sayısal modelden elde edilen neticeler ile de mukayese edilmiĢtir. Sayısal 

modelden elde edilen P-(yük-deplasman)eğrileri, deneyden bulunan P-

eğrileriyle = 0.25-0.5 aralığında çakıĢtırılarak kayma modülü değerleri 

bulunmuĢtur. 1-2 düzlemi için PK malzemesinin kayma modülü 2.75 MPa ve 2-

3 düzlemi için PK malzemesinin kayma modülü ise 2.52 MPa bulunmuĢtur. 

Benzer Ģekilde, elde edilen kayma parametrelerinin çok düĢük olduğu 

anlaĢılmıĢtır. Ayıca, sayısal model ile numune içinde ve özellikle numune 

köĢelerine yakın noktalarda gerilme dağılımının saf kaymadan çok uzak olduğu 

belirlenmiĢtir. 

 Analitik yöntem ile elde edilen P- eğrileri, deneyden bulunan P- eğrileriyle 

= 0.25-0.5 aralığında çakıĢtırılarak kayma modülü değerleri bulunmaya 

çalıĢılmıĢtır. 1-2 düzlemi için PK malzemesinin kayma modülü 4.14 MPa ve 2-3 

düzlemi için PK malzemesinin kayma modülü 4.83 MPa bulunmuĢtur. Wada vd. 

(2013)’de de yararlanılmıĢ olan analitik çözümün kuvvetli düzlem için iyi netice 

verdiği fakat zayıf düzlem için çok yüksek neticeler verdiği belirlenmiĢtir. 

 Numune köĢelerinde gerilme yığılmalarının meydana gelmesi ve kayma 

gerilmesi dağılımlarının üniform olmamasından dolayı elde edilecek kayma 

dayanımı değerlerinin anlamsız olacağı görülmüĢtür. Bu yüzden sayısal ve 

analitik modelden kayma dayanımları elde edilememiĢtir. 

Yukarıdaki maddelerden anlaĢılacağı üzere ÜRKD’nin, numune içinde saf 

kayma hali oluĢmamasından ötürü gerçeğe yakın netice vermediği ortaya çıkmıĢtır. Bu 

problemin, numunenin eğilmeye karĢı güçlendirilmesi ile ortadan kalkacağı 

düĢünülmektedir.
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